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Unit 1: Getting Started 
Unit Objectives 
In this unit, you will be introduced to Google Docs, explore the interface, learn basic concepts and 
apply various settings. Upon successful completion of this unit, you should be able to understand 
the following: 

 Docs Interface

 Docs Option
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Unit 1 Docs Interface Learn Tasks 
Lesson Topic Assessment Details 

Launch Docs Launch Docs 

Identify the Home Screen Select the area to complete each of the following: 
1) Display your recent documents. 
2) Create a document from a template. 
3) Select the area to create a new blank document. 
4) Select the area to search for specific documents. 

Know the Toolbar Select the option to do each of the following: 
1) Search the menus 
2) Undo/Redo 
3) Print 
4) Check spelling and grammar 
5) Paint format 
6) Zoom 
7) Text Formatting 
8) Insert or add elements 
9) Paragraph Formatting 
10) Clear Formatting 

Hide Menus 1) Hide Menus 
2) Show Menus Again 

Understand Online and Offline 1) Open a Document Online 
2) Enable Offline Access 

Customize Interface Display the following features: 
• Show equation toolbar 
• Show non-printing characters 

Turn Off Spell Check Turn Off Spell Check 

Configure Spell Check Add the word “Isograd” to your Personal dictionary 

Locate Add-Ons Display available add-ons. 
Identify Plugin Features Add the Translate All plugin 
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Unit 1 Docs Interface Practice Exercise 
Assessment Details 

1) Launch Google Docs 
2) Identify the following Home Screen sections 

• Recent documents 
• Templates 
• Create new document 

3) Open a blank Google Doc 
4) Hide the Menus 
5) Show the Menus 
6) Turning off the option to show the ruler 
7) Turn off spell check and grammar check 
8) Configure spell check to check in the Spanish language 
9) Add the word “Scrumdiddlyumptious” to the personal dictionary 
10) View available Add-ons and Extensions 
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Unit 1 Docs Interface Practice Questions 
 
 
Jamal is starting a new research paper for his history class. His teacher recommended using Google 
Docs because it allows him to work from home and school, collaborate with classmates, and access 
powerful writing tools. Jamal wants to make sure he sets up his document correctly and uses 
features that help him stay productive and focused. 

 
1) Jamal wants to start writing right away. What is the best way for him to open Google Docs on a 

school computer? 

a) Go to docs.google.com in a browser  
b) Open Microsoft Word 
c) Visit calendar.google.com 
d) Select the + icon in Gmail 

 
2) Once Jamal launches Google Docs, which feature on the home screen helps him reopen a file 

he was working on yesterday? 

a) Toolbar 
b) Recent Documents  
c) Add-ons 
d) Preview Panel 

 
3) Jamal wants to make the title of his paper bold and centered. Which area of the Docs interface 

allows him to do this quickly? 

a) Insert Menu 
b) The Sidebar 
c) Toolbar  
d) Document Title Field 

 
4) Jamal wants a distraction-free writing environment. What can he do to maximize his workspace 

in Google Docs? 

a) Enable Fullscreen Mode 
b) Collapse the toolbar 
c) Hide the menus  
d) Use a dark theme 

 
5) Jamal’s internet connection at home is sometimes unreliable. What feature should he enable 

to ensure he can continue writing without interruption? 

a) Voice typing 
b) Auto-correct 
c) Version history 
d) Offline access  

 
6) Jamal doesn’t like viewing the ruler and wants more space at the top of his page. How can he 

adjust the interface? 

a) Turn off spell check 
b) Switch to editing mode 
c) Hide the ruler from the View menu  
d) Collapse comments 
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7) Jamal is writing a quote in another language that keeps being underlined. What can he do to 
stop the red squiggly line from appearing? 

a) Highlight and delete the text 
b) Turn off spell check  
c) Change font color to white 
d) Remove formatting 

 
8) Jamal is writing part of his paper in Spanish. What setting should he update to ensure correct 

grammar and spelling suggestions in that language? 

a) Change the page orientation 
b) Turn off auto-correct 
c) Set the language to Spanish in the Tools menu  
d) Add a Spanish dictionary manually 

 
9) Jamal wants to use a citation generator for his bibliography. Where should he go to find and 

install one? 

a) Extensions menu > Add-ons > Get add-ons  
b) File menu > Download 
c) Format menu > Add plugin 
d) Insert menu > Extensions 

 
10) After installing an add-on for citations, Jamal notices a new menu appear. What is this menu 

called, and what can it help with? 

a) Tools panel; adding bookmarks 
b) Plugin panel; changing page layout 
c) Add-ons menu; using installed extensions  
d) Extensions panel; sharing files 
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Unit 1 Docs Options Learn Tasks 
Lesson Topic Assessment Details 

Create a Doc Create a new blank document 

View Options View the Doc at 50% 

Display a Doc Display the document in the pageless mode. 

View Docs View the Doc in Editing Mode, Suggestions Mode and View 
Mode. 

Name Docs Name the doc MyDoc. 

Copy a Doc Create a copy of MyDoc. 

Compare Docs 1) Download Compare Docs V2 from the platform. 
2) Compare the two documents. 

Manage Versions 1) Access the version history. 
2) Restore the previous version. 

Download Different Formats Download the document in PDF, Microsoft Word, and EPUB 
formats.  

Send as Email Attachment Send the document as an email attachment to your own email 
in PDF format. 

Publish to the Web Publish the document to the web and view it in a new browser 
tab. 

Print a Doc Print the Doc with the following: 
• Paper Size: A4 
• Pages per Sheet: 2 
• Margins: 2” 
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Unit 1 Docs Options Practice Exercise 
Assessment Details 

1) Create a new document 
2) Ensure the document is displayed in Print Layout mode and enable Show Ruler. 
3) View the document in Suggesting Mode 
4) Change the name of your document to Google Docs Practice 
5) Enter the text: Google Docs is a cloud-based word processing application that allows users 

to create, edit, and store documents online. It offers real-time collaboration, meaning 
multiple users can work on the same document simultaneously. 

6) Copy the document and name it Google Docs Practice Copy 
7) Edit the text to: Google Docs is a cloud-based word processing application that allows 

users to create, edit, and store documents online. With Google Docs, users can access their 
documents from any device with an internet connection, making it a convenient tool for 
both personal and professional use. 

8) Compare the two documents 
9) View the version history of the Google Docs Practice Copy 
10) Download the doc as a PDF 
11) Send the doc as an email attachment 
12) Publish the document to the Web 
13) Print the document 
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Unit 1 Docs Options Practice Questions 
 
You’ve just started your internship at a local nonprofit called Green Planet Alliance. Your supervisor 
has asked you to draft and manage a document called Spring Fundraising Campaign. You’ll need 
to create and format the document, track changes, manage versions, and share it with your team 
in multiple ways. Your work will support communication with donors and internal project 
documentation. 

 
1) You begin by creating a brand-new document to work on the campaign draft. What is the most 

efficient way to start this process? 

a) File menu > Open > New 
b) Insert menu > New Documenta 
c) Google Docs Home screen > Blank Document  
d) Tools menu > Create Doc 
 

2) Fill in the blank with the correct word.  
After creating the document, you want to adjust how you view it on screen. To change between 
viewing modes like Editing and Suggesting, go to the __________ menu. 

• View 
• Format 
• Insert 
• File 

 
3) You can display or hide rulers and outlines from the View menu to better organize your 

workspace. 

• True  
• False 

 
4) Your supervisor wants you to rename the document to Spring Fundraising Campaign. What is 

the correct way to name a document? 

a) Insert menu > Rename 
b) File menu > Rename 
c) Select the document title at the top and type the new name  
d) Right-click anywhere in the document and choose Rename 

 
5) Fill in the blank with the correct word.  

To make a duplicate of your document for testing edits, go to the __________ menu and select 
Make a copy. 

• Tools 
• Edit 
• File 
• Insert 

 
6) You’ve received a team member’s version of the campaign doc. You want to compare it to your 

current version. Where do you go? 

a) Tools menu > Compare documents  
a) Insert menu > Link > Compare 
b) View menu > Compare 
c) Add-ons > Comparison tool 
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7) You can download your Google Doc in different formats like .docx and .pdf using the Tools
menu.

• True
• False

8) Fill in the blank with the correct word.
To send your document to your supervisor directly via email, go to the __________ menu and
choose Email this file.

• File
• Edit
• Tools
• Share

9) Which option allows you to share your document on a webpage so it can be accessed publicly?

a) Tools menu > Share > Publish
b) File menu > Publish to the web
c) View menu > Enable web mode
d) Insert menu > Add to web

10) Fill in the blank with the correct word.
To view older drafts and revert if needed, go to the __________ menu and select Version History.

• File
• Edit
• Tools
• Insert

11) Once published to the web, changes you make to the document can automatically update the
published version.

• True
• False

12) You’re ready to print your finalized campaign document. Where do you go?

a) Tools menu > Print
b) View menu > Print
c) File menu > Print
d) Share button > Print

13) Match the feature with its purpose:

a) Compare Docs
b) Manage Versions
c) View Docs
d) Download

_____Displays a list of all your saved and recent documents  
_____Identifies differences between two versions of a document 
_____Lets you name and restore previous edits  
_____Exports the document in formats like PDF or Word  
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Unit 1 Create Project 
This simulated Create Project allows the application and demonstration of new knowledge and 
skills. 

1. Launch Google Docs

2. Identify the following Home Screen sections

a. Recent documents

b. Templates

c. Create new document

3. Open a blank Google Doc

4. Hide the Menus

5. Show the Menus

6. Customize the interface by turning off the option to show the ruler

7. Turn off spell check and grammar check

8. Configure spell check to check in the Spanish language

9. Add the word “supercalifragilisticexpialdocuious” to the personal dictionary

10. View available Add-ons and Extensions

11. Create a new document

12. Ensure the document is displayed in Print Layout mode and enable Show 
Ruler.

13. View the document in Suggesting Mode

14. Change the name of your document to Google Docs Project

15. Copy the document and name it Google Docs Project Copy

16. Compare the two documents

17. View the version history of the Google Docs Practice Copy

18. Download the doc as a PDF

19. Send the doc as an email attachment

20. Publish the document to the Web

21. Print the document
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Unit 1 Objective Assessment 
 

1) What is the first step to launch Google Docs? 

a) Select the File menu 
b) Go to Google Drive 
c) Visit the Google Docs website  
d) Open a Google spreadsheet 
 

2) Which of the following is found in the Google Docs Home Screen? 

a) Undo button 
b) Recent documents  
c) Text formatting options 
d) Hyperlink options 
 

3) Where do you find the option to turn off spell check in Google Docs? 

a) Tools menu  
b) View menu 
c) File menu 
d) Insert menu 
 

4) What happens when you hide the menus in Google Docs? 

a) It removes all content from the document 
b) The menus are no longer visible, but content is still editable  
c) It locks the document for editing 
d) It opens the print dialog 
 

5) Fill in the blank with the correct word.  
To configure Google Docs to check spelling and grammar in a different language, you go to the 
__________ menu and select the appropriate language under the Language settings. 

• View 
• Tools 
• Edit 
 

6) Fill in the blank with the correct word.  
To create a new document in Google Docs, select the blank document option under the 
__________  section. 

• Insert tab 
• File menu 
• Home screen 
 

7) You can view and manage document versions in Google Docs. 

• True  
• False 
 

8) When you configure the spell check to Always check spelling and grammar, it will correct 
mistakes in real-time. 

• True 
• False  
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9) How can you access and install new Add-ons in Google Docs? 

a) Tools menu > Add-ons > Get add-ons  
b) File menu > Add-ons > Install 
c) Extensions menu > Get Add-ons 
d) View menu > Extensions > Add-ons 
 

10) How do you change the font size of text in Google Docs? 

a) Right-click the text and choose Font Size 
b) Home screen > Select the A icon and adjust the size  
c) Format menu > Text Size > Increase/Decrease 
d) Select the text and select Ctrl + Shift + + 
 

11) Match the correct description to the feature in Google Docs. 

a) Comment 
b) Share 
c) Version History 
d) Table of Contents 

 

_____A feature used to track changes and restore previous versions  
_____A section for adding notes or feedback on specific parts of the document  
_____A tool used to share your document with other people  
_____Automatically generates a table listing headings and subheadings in the document 

 

12) Google Docs allows you to work offline if you enable offline mode in Google Drive. 

• True  
• False 
 

13) You can insert videos into a Google Docs document directly from YouTube. 

• True  
• False 
 

14) Fill in the blank with the correct word.  
To add a bullet list in Google Docs, go to the __________ menu and choose Bullets. 

• Insert  
• File  
• Format  
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Unit 1 Key Terms  
Term Definition  

App Menu  A navigational feature often found in software and websites that displays a 
list of available options or tools within the application.  

Chips  Interactive elements in Google Docs that represent and link to various types 
of data, such as people, dates, files, events, or add-on resources.   

Compare 
Documents  

A feature that highlights the differences between the two documents.  

Document 
Language  

The primary language setting of a document, which guides spell check and 
grammar analysis tools.  

Document Title  The name assigned to a document file, which is displayed at the top of the 
document window and used to identify the file in storage.  

Duplicate  To make an exact copy of a document, which can then be modified 
independently of the original.  

Editing Mode  Allows direct changes to be made to the document.  

Email Attachment  A file sent along with an email message for the recipient to download and 
view.  

Full Screen  A mode that expands the document to cover the entire screen, hiding 
menus and toolbars.  

Full-Screen Mode  A display setting that allows content to take over the entire screen, hiding 
the operating system's interface and other applications.  

Google Account  A user profile that provides access to services owned by Google such as 
Gmail, Google Drive, and YouTube, along with integration capabilities for 
various third-party applications.  

Google Drive  A cloud storage service provided by Google that allows users to save files 
online and access them from any smartphone, tablet, or computer.  

Google Workspace 
Marketplace  

A digital shopping location where users can find and install additional 
software components for Google Workspace applications.  

Grammar Check  An extension of spell check that also analyzes the grammatical structure of 
sentences to identify errors.  

Integration  The process of combining or adding components to a system to provide new 
functionalities without disrupting the existing setup.  

Interface  The point of interaction between a user and a software program, featuring 
elements like buttons, menus, and icons that facilitate user input and 
operation.  
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Menu Bar  The horizontal bar at the top of the application window that contains drop-
down lists of options for various functions.  

Offline  Working without an internet connection.  

Online  Working with an internet connection.  

Pageless Display  A continuous view of a document without page breaks.  

Plugins  Software add-ons that enhance the basic functionalities of an application by 
adding new features.  

Print Settings  Options that allow you to adjust how your document will be printed, such as 
the number of copies or page layout.  

Restore  To bring back a previous version of a document.  

Shareable Link  A URL that allows users to access content. 

Spell Check  A feature in word processing programs that finds spelling errors in a text.  

Suggesting Mode  Enables proposed edits that appear as comments for review.  

Sync  To update and save changes across all devices when reconnected to the 
internet.  

Template  A pre-designed document format that users can utilize for creating, editing, 
and sharing various types of written content.  

Template Gallery  This is a collection of pre-designed layouts provided by software 
applications, allowing users to select and use them as a starting point for 
creating various types of content.  

Toolbar  A graphical presentation of command buttons and icons arranged 
horizontally or vertically on the screen to facilitate quick access to program 
features.  

Version History  A record of all changes made to a document over time.  

Viewing Mode  Allows you to observe the document without making any changes.  

Zoom  A feature in digital interfaces that allows users to change the magnification 
of the content displayed on the screen.  
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